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Δ Description Produit

FXcommander_Editor est un logiciel de programmation d'effets conçu pour la FX commander. Il 
permet de réaliser des programmes pour les appareils DMX et pyro, en les synchronisant avec la 
musique. Le mode graphique et le mode tableau interchangeables le rendent plus convivial pour la 
programmation. Les fichiers peuvent être téléchargés via une clé USB ou un câble USB. En plus de la 
programmation, des fonctions telles que la sortie de la liste des projets, la liste des appareils et les 
statistiques permettront de réduire la charge de travail de l'opérateur.

REMARQUE : Le logiciel FXcommander_Editor ne peut être ouvert que lorsque la clé USB de SHOWVEN est 
insérée dans l'ordinateur. Elle peut être retirée après avoir accédé à l'interface d'édition. La clé USB se trouve 
dans le package FX commander, veuillez la conserver soigneusement.

Δ Introduction

Un projet complet devrait comprendre quatre dossiers (téléchargement, rapport, wave, xml) et un 
fichier de projet .pro, comme indiqué ci-dessous. Un projet correspond à un spectacle continu. 

Le dossier de téléchargement contient trois fichiers de téléchargement : csv, dot et wave. Ces trois fichiers 
peuvent être téléchargés vers le FXcommander à partir du logiciel Fxcommander_Editor via un câble USB, ou 
copiés sur le FXcommander via une clé USB.

Le dossier de rapport contient 2 fichiers Excel

                            Deux feuilles : feuille DMX et feuille pyro. Le fichier Fire_build affiche les noms des appareils, 
les quantités, les adresses, etc., ce qui est pratique pour l'opérateur pour organiser et préparer le spectacle.

Fire_build.xlsx - DMX sheet 

Fire_build.xlsx - Pyro sheet 

 liste toutes les séquences et leurs paramètres dans l'ordre chronologique des séquences 
créées dans le projet.



Fire_table.xlsx 

WAVE FOLDERS contient le fichier musical utilisé dans le projet en cours et qui peut être chargé via le logiciel 
Fxcommander_Editor. 

Xml folder 
Δ Interface Principale

L'interface principale du logiciel peut être divisée en 5 régions, comme l'indique l'image ci-dessus.

Le dossier xml est utilisé pour stocker les fichiers de bibliothèque. Les fichiers de bibliothèque sont divisés en 
bibliothèque d'appareils (format .xml) et bibliothèque de feux d'artifice (format .xlsx) ; la bibliothèque 
d'appareils avec le préfixe dev_SHOWVEN sera reconnue comme la bibliothèque d'appareils SHOWVEN (ne 
peut pas être modifiée par le logiciel Fxcommander_Editor). La bibliothèque d'appareils préfixée par 
dev_USER sera reconnue comme une bibliothèque utilisateur (qui peut être modifiée par le logiciel 
Fxcommander_Editor). Le préfixe de la bibliothèque de feux d'artifice est pyro_SHOWVEN pour être reconnu 
par le logiciel Fxcommander_Editor. Le format de toutes les bibliothèques est strictement défini, veuillez vous 
référer à l'exemple et le nommer en conséquence.



1. Zone de contrôle 

4. Zone d'édition des repères (CUE) 
2. Zone d'affichage des fichiers de bibliothèque
5. Zone de liste des appareils

3. Zone de forme d'onde WAVE 

6. Menu

Les fonctions de la zone de contrôle : 

1) Ajouter des fichiers de musique au format wave, télécharger les fichiers de musique wave vers FXcommander.
2) Créer des fichiers dot et CSV, télécharger les fichiers dot et CSV vers FXcommander.
3) Lire, mettre en pause, arrêter la musique.
4) Ajuster le volume.
5) Ajouter des fichiers de repères (Cue) dans la zone d'édition des repères.
6) Affichage des paramètres temporels importants, notamment :
7) Cue : Durée de lecture actuelle de la musique
8) Len : Durée totale de la musique
9) Nex : Le temps restant jusqu'au prochain fichier de repères (Cue) pendant la lecture de la musique

10) Pos : La position actuelle de la souris sur la ligne de temps de la musique
11) Ajuster la taille des graphiques de musique (réglée en modifiant la valeur de la Loupe Audio).
12) Ajuster le décalage entre le fichier dot et le fichier de musique wave (ajuster le temps de déclenchement 

anticipé global du fichier dot en modifiant l'heure de début audio).
13) La partie inférieure montre la date de la version actuelle du projet. Cliquez sur Fichier -> Créer un fichier de 

téléchargement ou téléchargez le fichier du projet pour enregistrer la date de mise à jour.

La zone d'affichage des fichiers de bibliothèque contient les appareils et les effets, y compris la bibliothèque pyro et la 
bibliothèque d'appareils. La bibliothèque d'appareils est divisée en bibliothèque SHOWVEN (non modifiable) et 
bibliothèque utilisateur (modifiable, permettant d'ajouter, de supprimer et de modifier des équipements). 
Sélectionnez n'importe quelle zone de fichier de bibliothèque, saisissez des caractères pour accéder à l'appareil 
commençant par la même lettre, ou utilisez les flèches haut et bas pour trouver et sélectionner l'appareil. Double-
cliquez pour afficher et modifier les appareils de la bibliothèque (à l'exception de la bibliothèque SHOWVEN). De plus, 
supprimer et modifier l'appareil dans le fichier de bibliothèque n'affectera pas l'appareil sur le terrain.
Le menu d'opérations de la bibliothèque utilisateur est indiqué dans le tableau suivant :

Menu Principal Menu Secondaire 

Ouvrir le Fichier 

Appareil
Créer un Appareil

Modifier l'Appareil (apparaît uniquement lorsque l'appareil est sélectionné)

Supprimer l'Appareil (apparaît uniquement lorsque l'appareil est sélectionné)

Effet
Créer un Effet

Modifier l'Effet (apparaît uniquement lorsque l'effet est sélectionné)

Supprimer l'Effet (apparaît uniquement lorsque l'effet est sélectionné)

Enregistrer le XML Utilisateur
Fermer la Bibliothèque Utilisateur

La zone de forme d'onde WAVE affiche la courbe audio de la musique actuellement ajoutée. Sélectionnez la 
courbe audio et faites glisser la molette pour zoomer et dézoomer dans la courbe audio. Déplacez la 
souris dans la zone de forme d'onde WAVE et double-cliquez pour faire glisser n'importe où pendant la lecture 
de la musique.
La zone d'édition des repères (Cue) permet d'éditer les fichiers de repères (Cue), y compris les 
modes graphique et tableau. En mode tableau, les fichiers de repères (Cue) sont disposés par ordre d'ajout du 
haut vers le bas ; le fichier de repères (Cue) à déclencher pendant la lecture de la musique est en blanc, et le 
repère en cours de déclenchement est en rouge, les repères avant le temps de lecture actuel de la musique 
sont en gris. Les modes tableau et graphique peuvent être basculés dans Paramètres -> Affichage -> 
Graphique / Tableau.

Les repères (Cue) sont disposés par défaut dans l'ordre chronologique. En cliquant sur différents menus, les repères (Cue) peuvent être triés 
selon différents critères (par exemple, en cliquant sur "Modèle", les repères (Cue) seront disposés dans l'ordre de :



La zone de liste des appareils comprend les appareils d'effets spéciaux et les appareils pyrotechniques. 
Pendant la lecture de la musique, si un appareil est utilisé dans le fichier de repères (Cue), l'appareil 
correspondant dans la zone de liste des appareils deviendra rouge. Si le projet actuel utilise à la fois des 
appareils d'effets spéciaux et des appareils pyrotechniques, et que le mode défini est automatique, le passage 
automatique entre l'appareil pyrotechnique et l'appareil d'effets spéciaux peut être réalisé pendant le 
processus de déclenchement. Le mode automatique et le mode manuel peuvent être basculés dans 
Paramètres -> Fenêtre d'Appareils -> Automatique/Manuel.

Menu 

Menu principal Menu secondaire Menu tertiaire

Projet

Nouveau Projet
Ouvrir le Projet

Ajouter un Projet
Enregistrer le Projet

Enregistrer Sous le Projet
Enregistrer Sous Excel (.xlsx)

Enregistrer Sous en tant que Construction (Build)

DMX Ouvrir la Bibliothèque Showven
Ouvrir la Bibliothèque Utilisateur

Pyro Ouvrir la Bibliothèque Pyro

Fichier

Créer un Fichier de Téléchargement
Télécharger la Musique

Télécharger le Fichier Dot
Annuler

Rétablir

Paramètres

Language 
English 

Voir 
Graph 

Table 

Fenêtre des Appareils Auto 



Manuel 

MIDI 

Ecrire Midi 

Lire Midi 

Smpte 

Déconnecter
Aide A Propos

Projet -> Nouveau Projet : Crée un nouveau projet ; après avoir cliqué dessus, une fenêtre de sélection de dossier s'ouvrira. Un nouveau 
projet sera créé après avoir sélectionné le dossier, entrez le nom du nouveau projet.
Projet -> Ouvrir le Projet : Ouvrir un projet existant
Projet -> Ajouter un Projet : Ajouter un autre projet au projet actuel
Projet -> Enregistrer le Projet : Enregistrer le projet actuel
Projet -> Enregistrer Sous le Projet : Enregistrer le projet actuel sous un autre nom
Projet -> Enregistrer Sous Excel(.xlsx) : Générer le fichier fire_table.xlsx
Projet -> Enregistrer Sous Build : Générer le fichier fire_build.xlsx
DMX -> Ouvrir la Bibliothèque Showven : Ouvrir la bibliothèque SHOWVEN
DMX -> Ouvrir la Bibliothèque Utilisateur : Ouvrir la bibliothèque utilisateur
Pyro -> Ouvrir la Bibliothèque Pyro : Ouvrir la bibliothèque pyro
Fichier -> Créer un Fichier de Téléchargement : Créer des fichiers de téléchargement, comprenant trois fichiers : .dot, .csv et .wave
Fichier -> Télécharger la Musique : Télécharger des fichiers de musique, nécessite une connexion avec FXcommander
Fichier -> Télécharger le Fichier Dot : Télécharger le fichier Dot, nécessite une connexion avec FXcommander
Fichier -> Annuler : Annuler l'action précédente, telle que créer, copier, déplacer, supprimer, modifier, etc. de repères (Cue)
Fichier -> Rétablir : Rétablir l'action précédente annulée, telle que créer, copier, déplacer, supprimer, modifier, etc. de repères (Cue)
Paramètres -> Langue -> Anglais/Chinois : Changer la langue
Paramètres -> Affichage -> Graphique/Tableau : Basculer entre la vue graphique et la vue tableau de la zone d'édition des repères (Cue)
Paramètres -> Fenêtre des Appareils -> Automatique/Manuel : Réglage automatique / manuel dans la région de liste des appareils lorsque le 
projet est en cours d'exécution.
Aide -> À Propos : Vérifier la version actuelle du logiciel FXcommander_Editor.

Δ Opération du logiciel
1. Insérer le disque USB dans l'ordinateur.
Le logiciel FXcommander_Editor ne peut être ouvert que lorsque le disque USB de SHOWVEN est inséré 
dans l'ordinateur. Il peut être retiré après avoir accédé à l'interface d'édition.
Le disque USB se trouve dans le package FXcommander, veuillez le conserver soigneusement.
2. Créer un nouveau projet
3. Double-cliquez sur l'icône du logiciel pour accéder au logiciel.



Sélectionnez le dossier pour enregistrer le projet, puis cliquez sur "Sélectionner le Dossier" (le dossier 
sélectionné devrait contenir au moins deux dossiers nommés "wave" et "xml", où "wave" contient les fichiers 
de musique et "xml" contient les fichiers de bibliothèque).

Saisissez le nom du projet, puis cliquez sur "OK" pour accéder à l'interface principale.



3. Ajouter des fichiers de musique des appareils

Cliquez sur "Ouvrir la Musique" pour sélectionner la musique que vous souhaitez ajouter, puis cliquez sur 
"Ouvrir". Une fois ouverte, le logiciel sauvegardera automatiquement les fichiers de musique dans le dossier 
"wave".

.

Sélectionnez Showven_Lib, faites un clic droit sur la zone vide en bas à gauche, sélectionnez "Ouvrir le 
Fichier", choisissez le fichier de bibliothèque que vous souhaitez ouvrir, puis cliquez sur "Ouvrir". Ouvrez 
également User Lib et Pyro Lib de la même manière. Après l'ouverture, le fichier de bibliothèque sera 
automatiquement sauvegardé dans le dossier "xml"

Fxcommander_Editor peut ouvrir plusieurs fichiers de bibliothèque, si le même fichier de bibliothèque est 
ouvert plusieurs fois, il sera affiché de manière répétée.. 



Faites un clic droit sur l'appareil que vous souhaitez ajouter, puis cliquez sur "Ajouter à l'Appareil". Ensuite, 
définissez l'adresse de départ et le nombre d'appareils, puis cliquez sur "OK".

4. Éditer le Fichier de Repères (Cue)
Method A:

Faites un clic droit sur la position sélectionnée dans la zone d'édition des repères (Cue) et cliquez sur "Créer" 
pour accéder à l'interface d'édition des repères (Cue).

Sélectionnez "DMX", maintenez la touche "Ctrl" enfoncée et cliquez sur les appareils pour les sélectionner, ou 
maintenez le bouton gauche de la souris enfoncé et faites glisser pour sélectionner les appareils. Réglez les 
paramètres, puis cliquez sur "OK".

Les principaux paramètres comprennent :

"Timecode" (code temporel) / "Duration" (durée en secondes) / "Tri Delay" (délai de déclenchement en 
secondes) / "Prefire" (temps de pré-allumage en secondes - le temps de pré-allumage ne peut pas dépasser la 
durée totale du fichier de repères (Cue)) / "Times" (nombre d'exécutions) / "Cycle" (cycle d'exécution) /
"Model" (modèle) / "Effect" (effet) (les modes d'effet incluent de gauche à droite, de droite à gauche, 
synchronisation (le réglage du temps de déclenchement est sans signification dans ce mode), des côtés au 
milieu, du milieu aux côtés)



Faites un clic droit sur la position sélectionnée dans la zone d'édition des repères (Cue) et cliquez sur "Créer" 
pour accéder à l'interface d'édition des repères (Cue).

Sélectionnez "Pyro" et choisissez la bibliothèque Pyro que vous souhaitez ajouter dans la colonne Pyro, par 
exemple "Cakebox Red Bloom" (la bibliothèque Pyro est préalablement éditée, vous pouvez la modifier en 
bas à gauche, ou modifier les paramètres tels que l'heure de début, la durée, le délai de déclenchement, le 
pré-allumage, le mode, etc. dans l'interface d'édition des repères (Cue), mais ils ne seront pas sauvegardés).

Ensuite, sélectionnez l'adresse de l'appareil, la ligne (de 0 à F) représente l'adresse de l'igniteur sur chaque 
esclave, et la colonne (de 00 à FF) représente l'adresse de l'esclave.

L'image ci-dessous montre les têtes d'allumage n°1 à n°8 sélectionnées de l'esclave n°00. Cliquez sur "OK" 
pour enregistrer les réglages



Method B:  

Cliquez pour passer en mode édition (la couleur devient rouge), puis cliquez sur ▷ pour lire la musique.

Appuyez sur la barre d'espace en fonction du rythme de la musique pendant la lecture pour ajouter des 
fichiers de repères (Cue) vides. Après avoir ajouté le repère (Cue) vide, cliquez sur        "Réinitialiser" (Reset).



Faites un clic droit sur le repère (Cue) vide, puis cliquez sur "Modifier" pour accéder à l'interface d'édition des 
repères (Cue). Sélectionnez "DMX", maintenez la touche "Ctrl" enfoncée et cliquez sur les appareils pour les 
sélectionner, ou maintenez le bouton gauche de la souris enfoncé et faites glisser pour sélectionner les 
appareils. Réglez les paramètres, puis cliquez sur "OK".

Les principaux paramètres comprennent :
"Timecode" (code temporel) / "Duration" (durée en secondes) / "Tri Delay" (délai de déclenchement en 
secondes) / "Prefire" (temps de pré-allumage en secondes - le temps de pré-allumage ne peut pas dépasser la 
durée totale du fichier de repères (Cue)) / "Times" (nombre d'exécutions) / "Cycle" (cycle d'exécution) / 
"Model" (modèle) / "Effect" (effet) (les modes d'effet incluent de gauche à droite, de droite à gauche, 
synchronisation (le réglage du temps de déclenchement est sans signification dans ce mode), des côtés au 
milieu, du milieu aux côtés)

Pour éditer plusieurs repères (Cue) simultanément :
1. Appuyez et maintenez la touche "Ctrl" enfoncée.
2. Cliquez pour sélectionner les repères (Cue) que vous souhaitez éditer.
3. Faites un clic droit pour afficher le menu contextuel.
4. Sélectionnez "Multi Change" (Modification Multiple)



Sélectionnez l'appareil, réglez les paramètres souhaités, puis cliquez sur "OK".

L'édition de plusieurs repères (Cue) en même temps modifiera tous les repères (Cue) DMX, Pyro ou vides 
sélectionnés en leur attribuant les mêmes données. Si vous modifiez un repère (Cue) vide en repère (Cue) 
DMX ou Pyro, certains champs obligatoires doivent être remplis, tels que l'appareil sélectionné, l'effet 
sélectionné, la durée, etc. ; si vous ne renseignez pas ces champs obligatoires, la modification du repère 
(Cue) vide n'aura pas d'effet.

Editer un repère (Cue) Pyro :

Faites un clic droit sur le repère (Cue) vide / Cliquez sur "Modifier" pour accéder à l'interface d'édition des 
repères (Cue) / Sélectionnez "Pyro" en choisissant le nom du dispositif pyrotechnique dans la liste déroulante / 
En raison du grand nombre de différents types de dispositifs pyrotechniques, vous pouvez utiliser la fonction de 
filtrage des champs tels que le fournisseur, la forme du ventilateur, la classe, la couleur, etc
.
La bibliothèque Pyro est préalablement éditée et peut être modifiée en bas à gauche, ou vous pouvez modifier 
les paramètres tels que l'heure de début, la durée, le délai de déclenchement, le pré-allumage, le mode, etc. 
dans l'interface d'édition des repères (Cue). Ces changements ne seront effectifs que pour le repère (Cue) 
actuel et n'affecteront pas les paramètres dans la bibliothèque Pyro. 



Ensuite, sélectionnez l'adresse de l'appareil. La ligne (de 0 à F) représente l'adresse de l'igniteur sur chaque 
esclave, et la colonne (de 00 à FF) représente l'adresse de l'esclave.

L'image ci-dessous montre les têtes d'allumage n°1 à n°8 sélectionnées de l'esclave n°00. Cliquez sur "OK" pour 
enregistrer les réglages.

Après avoir réglé les paramètres, jouez la musique pour vérifier l'effet du réglage.

Ensuite, cliquez sur "Project -> Enregistrer le Projet" pour enregistrer le projet, puis cliquez sur "Fichier -> 
Créer un Fichier de Téléchargement" pour créer les fichiers de téléchargement.



Δ Créer une Bibliothèque Utilisateur (User Lib) 

1.Créer un Appareil dans la Bibliothèque Utilisateur (User Lib)
Sélectionnez User_Lib, faites un clic droit sur la zone inférieure et sélectionnez Appareil (Device) -> Créer 
un Appareil (Create Device), puis la fenêtre ci-dessous s'affichera.

2. Ajouter un Appareil
Saisissez les paramètres de l'appareil et cliquez sur "OK" pour enregistrer (* indique les champs obligatoires).



3. Ajouter un effet pour l'appareil
Faites un clic droit sur le nom de l'appareil que nous venons d'ajouter, sélectionnez "Effet (Effect) -> Créer 
un Effet (Create Effect)".

Configurer les paramètres de l'effet et cliquez sur "OK" pour enregistrer (* indique les champs obligatoires).



4. Pour enregistrement le fichier de bibliothèque : 
1. Déplacez le curseur vers la zone d'affichage des fichiers de bibliothèque (Lib).
2. Faites un clic droit et cliquez sur "Enregistrer le XML de l'Utilisateur" (Save User Xml) pour sauvegarder les 
paramètres

Δ Créer un effet Pyro 

Sélectionnez Pyro_Lib, faites un clic droit sur l'espace vide de la zone d'affichage des fichiers de bibliothèque 
(Lib), puis cliquez sur "Créer" (Create). 



Saisissez les paramètres et cliquez sur "OK" pour enregistrer les réglages.

Déplacez le curseur vers la zone d'affichage des fichiers de bibliothèque (Lib), faites un clic droit, puis cliquez 
sur "Enregistrer en CSV Pyro" (Save Pyro Csv) pour sauvegarder les paramètres.



Δ Fusionner des Fichiers de Projet

 Fusionner des Fichiers de PFusionnez deux fichiers de projet comme indiqué ci-dessous. 

Cliquez sur "Project -> Ajouter un Projet".

Sélectionnez le projet que vous souhaitez fusionner, puis appuyez sur "Entrée" (Enter).



Réglez le décalage horaire du premier repère (Cue) du projet ajouté, puis cliquez sur "OK".

Les projets fusionnés sont affichés comme ci-dessous.

Remarques concernant la fusion de projets :

Les adresses DMX des projets fusionnés ne peuvent pas être occupées par des appareils différents. Veuillez 
vérifier les adresses DMX des appareils après la fusion et assurez-vous que les valeurs des canaux DMX ne 
s'influencent pas mutuellement.



Δ Opération des touches de raccourci 

Raccourci Plage Fonction

Enter Lib File Ajouter l'appareil du fichier de bibliothèque (Lib) au dispositif de scène.

Delete ALL Supprimer les éléments sélectionnés (*).

/ Lib File Haut / Bas
/ Cue Repère (Cue) vers le haut / vers le bas
 / Cue Déplacement du repère (Cue) vers l'arrière / vers l'avant de 10 ms.

Shift +  / Cue Déplacement du repère (Cue) vers l'arrière / vers l'avant d'1 seconde.

Ctrl +  / Cue Déplacement du repère (Cue) vers l'arrière / vers l'avant d'1 minute.

Alt +  / Cue Déplacement du repère (Cue) vers l'arrière / vers l'avant d'1 heure.

Ctrl + C Cue Copier le repère (Cue) sélectionné.

Ctrl + V Cue 
Coller le repère (Cue) copié à la position actuelle de la 
souris (peut être collé entre les projets).

Ctrl +shift +V Cue 
Coller le repère (Cue) copié à la position 
précédente (peut être collé entre les projets).

Ctrl + a Cue Sélectionner tous les repères (Cue).
Space Cue Lorsque le point rouge est activé, appuyez sur la touche Espace pour créer un repère (Cue) vide.

Ctrl Cue Maintenez la touche "Ctrl" enfoncée pour sélectionner plusieurs repères (Cue).

Shift Cue 
Déplacez le repère (Cue) en maintenant le bouton gauche de la souris enfoncé et en 
déplaçant la souris tout en maintenant la touche "Shift" enfoncée.
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